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Further Photoshop CS5 Discussion

Audience and Project Requirements

Identify the purpose, audience, and audience needs for your Photoshop
content

Before you start any Photoshop Design project, it will help to analyze your
client’s and your end user’s needs to determine the project’s objectives. These
objectives are essential to shape the right design, find appropriate solutions, and
keep your project on track. Be sure to document your findings and have them
accessible to anyone working on the project because sometimes the most
obvious, important objectives are easily overlooked in the hustle of a project
pipeline. You should speak with the client and discuss the following questions:

e What is the purpose of the project? Evaluate the client’s goals for the
project. Will the content be educational, entertaining or informational?
What kinds of media formats do they wish to include? What functionality
is required to accomplish their goals? What level of interactivity do they
want to offer their users?

e Who is the target audience? Defining target demographics is important
in determining how best to communicate the projects content. Key
demographics can include (but are not limited to) age group, gender, level
of computer literacy, education, wealth bracket and geographical location.
Demographics will vary from project to project.

e What are the audience’s needs? Imagine yourself in your audience’s
shoes: what do you think they want from your Photoshop Project, and
how can you best deliver that experience to them? Factors such as
usability, level of engagement, accessibility, time commitment, and
required technology are all examples of how a user’s needs will have to be
addressed to shape the best experience for them.

Copyrights

Demonstrate knowledge of standard copyright rules (related
terms, obtaining permission, and citing copyrighted material)



First review the following terms:

Intellectual Property - can be any original work in the form of a design, text,
photo, video, sound, logo, name or innovation that is used commercially or as a
form of expression.

Copyrighted - the copyright law protects the ownership of intellectual property
once it has been created in a fixed medium with or without applying for a federal
copyright. In order to reuse or reproduce copyrighted property that is not yours
written permission must be obtained from the creator or owner. Many cases of
obtaining permission will also include paying royalties. Whenever you see
“copyright” or the © symbol, author name and/or published date that work falls
under copyright protection. It is safe to assume any work you see, hear or read
is copyrighted unless it comes with a statement that that you may reproduce it
without permission from the author/owner.

Fair Use Doctrine - this creates a loophole in the copyright law whereby
copyrighted material can be reused in part as long as it falls under the guidelines
of “fair use”. These “fair use” guidelines loosely stand to help the flow of
information to the public as long as the usage is not at too great of a conflict to
the original work. Usually educational purposes fall under “fair use”.

Derivative Work - is a new product that includes an aspect of a previously
copyrighted work.

Citing online copyrighted material:

When reusing a copyrighted work under the Fair Use Doctrine you should always
cite the original material. For video, audio, text, images and websites found
online you should always cite the creator(s), the title, the creation date, the URL
and a brief description may also be necessary.

Project Management

Understand project management tasks and responsibilities

The Project Plan

A project plan is a list of guidelines to follow to control and execute a project
from start to finish. These guidelines define the project scope, including details
of project specifications, internal due dates for the completion of specific tasks,
milestones for project deliverables, a client approval process, and a project
timeline. Possible deliverables for a web site may include sketches, wireframes,
mockup designs, interaction/animation storyboards, site map structure and
prototypes. The project plan also details resource allocation, which indicates
which tasks go to which team members.

Scope creep (or feature creep) is the expanding of work beyond the original
project plan, and it happens on just about every project. The effects of creep can
have a devastating impact on everyone’s time and the client’s expectations.



Therefore the project plan should contain some “padding” to allow for the
shifting of internal due dates, so that critical tasks are not held up by other tasks
taking too long. Examining a project’s structure, breaking it down into detailed
tasks, and assessing which tasks may encounter complications are all essential
steps. As always, timely communications between team members and the client
are a key factor in the project’s success.

The phases of the project plan are:

Analysis and Planning - The first step where client goals and target audience
considerations are established and initial project planning begins.

Design — A plan starts to take visual form in style guides, color schemes,
wireframes, graphics and design mockups.

Building/development - Prototypes are built that include the structure,
interactivity and functionality for the website content. Graphics are also
integrated.

Testing - Thorough quality assurance testing is performed to uncover bugs,
usability issues or other possible errors and report them to the design and
development team for revision.

Implementation/Launch - A project is in its final stage, the bugs are
squashed and the client has approved it to launch. You're ready to “go live” and
make the web site available to the pubilic.

Communicate with Others about Design Plans

You will need a project manager to lead and manage communications of your
project to your team. The project manager will keep the team on task and on
time. If the project manager sets up a clear process of communication the team
will be able to anticipate and solve project problems and issues quickly. Some
potential issues that may occur could be:

. Poor deliverable quality.

Incomplete or poor communication with the client.
Inaccurate or slow team communication.

Multiple change orders from the client or amongst the team.
Unclear goals, objectives and roles.

Slow feedback from the client.

Scope creep is a problem that can occur with any project. Scope creep is when
the requirements of project change continuously during construction of the
project. It usually happens at the tail end of the project. It makes sense to
allow in your project plan for some Scope creep but a way to limit this is to have
clear definitions goals and objectives before the project construction begins.



How to Organize and Customize the Photoshop Workspace

Just like all other Creative Suite applications you can customize the Photoshop
workspace. You can arrange the workspace by moving the various bars and
panels. You can move panels by selecting a panels tab and dragging it to a new
location. You can use the Workspace Switcher to reset the workspace, save a
custom workspace or switch between workspaces. The workspace switcher is
located on the Application Bar or by expanding the switcher to make some or all
of the live workspaces visible. Live Workspaces are a series of buttons on the
Applications bar that display the preset Photoshop workspaces or custom
workspaces you have created.

Digital Cameras and Photoshop CS5

It is important to have a basic understanding of the functions of a digital camera
when enhancing your photographs using Photoshop CS5. The following terminology
will be helpful when working in Photoshop CS5 with your Digital Camera.

Focusing — Almost all digital cameras have an option for automatic or manual
focusing.

Flash - the flash on your camera creates artificial light for your photograph.

Mega Pixels — the more mega pixels the camera can process the higher the quality of
the images/photographs.

Metering - refers to a camera's analysis of the lighting conditions of a scene. The
camera (or the photographer) will then use this analysis to determine the proper
settings for the camera. A Light Meter was (and in some cases, still is) commonly
employed by professional photographers, but more often than not the camera's own
built-in meters are used to set up a shot.

Most cameras allow a user top choose between spot, center-weighted average, or
multi-zone metering modes. With spot metering, the camera only measures a tiny
part of the scene (usually the center). Spot metering is usually used to properly
expose a single element in a scene when the rest of the scene may be blown out, or
too dark to see.

For center-weight metering, the meter concentrates most of its sensitivity towards
the central part of the viewfinder, but to a larger area than spot metering. This will
produce similar results to spot metering, but with greater emphasis on the overall
balance of the scene. A variation of this mode is average metering, where the
camera uses the light information coming from the entire scene and averages for the
final exposure setting, with no weight given to any single element.

On many cameras, multi-zone metering has become the default setting. In multi-
zone metering the camera samples light intensity in several points in the scene,
combining the results to determine the best exposure. The actual nhumber of zones
used varies wildly from camera to camera, from several to over a thousand.
Multi-zone tends to bias its exposure towards the focus point, to try and ensure that
the point of interest has been exposed properly. To accomplish this, a database of
many thousands of exposures is pre-stored in the camera, and the camera's built-in
processor will analyze the pattern of the image to attempt to determine what is



being photographed, and this what the optimum settings should be.

Zoom - allows the photographer to get closer to the subject of the image without
actually physically moving. The three types of zoom on a digital camera are digital
zoom, optical zoom, and extended optical zoom.

Understanding Adobe Photoshop CS5

The Adobe Photoshop CS5 workspace like all CS5 Suite Workspace comes with
panels, bars, and a window. All workspaces can be found within the application
frame. You can customize the Photoshop workspace by re-arranging the panels
and bars. You can move panels in the workspace by selecting the tab on the
panel and dragging it. You can reset the workspace, add a workspace, save a
custom workspace, or switch between different workspaces using the workspace
switcher. The workspace switcher can be accessed on the application bar.
Photoshop has a tool called Live Workspaces that creates buttons for the
standard and custom workspaces you are working on.

Photoshop allows you to view default and custom short-cuts. To view or assign
shortcuts to a workspace, click on window in the Application Bar (Menu Bar in
MAC), select workspace, click on Short-cuts & Menu, and then click the Short-
cuts tab.

Photoshop has a viewing option called the N-up view located in the Application
menu. You can find it by selecting Arrange Documents. The N-up View allows
you to see multiple Photoshop Documents at the same time or compare one
document to another.

In the Photoshop Tools Panel, Adobe provides quick access to a number of tools.
The Tools are placed into different categories. Those categories are Navigation
and 3D tools, Drawing and Type tools, Retouching tools, Painting tools,
Measuring tools, Crop and Slice tools and Selection tools. The icons on the panel
have drop-down selectors that give you access to the options for each tool.

To restore preferences to the default settings select Alt+Shift+Ctrl
(Option+command+Shift on MAC) when you open Photoshop. You then can
delete the settings when the application asks you what you want to do. You can
customize your preference settings in the Preferences dialog box. You can
access the preferences dialog box through Edit on the Application menu.

Photoshop CS5 Masks and Modes

You can mask areas of an image using Photoshop’s layer and vector masking
tools. A layer Mask is image resolution dependent. You can make changes to
the Layer mask using selection or painting tools. A vector mask is image
resolution independent and is created using drawing tools. In the Layers panel
there are thumbnails for layer mask or vector mask. To use the layer mask tool
you select the add layer mask button in the Layer panel or select the Add pixel
mask button in the Masks layer. To add a vector mask click on a drawing tool
and then select add a vector mask from the Masks panel. In the mask panel



you can make many adjustment to your masks. You can edit an mask by using
a painting or drawing tool by selecting the Fill pixels button on the options bar.
Photoshop allows you to add a blending mode to your images. You use the
blending mode to change how pixels in the layer blend with the pixels in the
same location in the layer below. To select a blending mode select the blending
mode menu in the Layers panel. Drag a layer to the top of the New Layer button
to duplicate a layer.

Mask Density can be adjusted by using the density slider in the Masks panel.
Changing the density adjusts the opacity of the Mask.

On the Layer menu, select Matting, and then click on the Color Decontamination
command to remove halos on an edge of an image that you have removed from
its background.

Nesting Layer Groups will organize and reduce clutter in the Layers panel. You
nest layer groups by placing one group inside of another group.

Importing, Exporting, Organizing and Saving your Photoshop Files and
Images

Bringing images into Photoshop is easy. You have several ways to do this. The
most common is to use the Open command. The Open command opens an
image in its own PS document. Another way to bring images into Photoshop is
to use the Place command. The Place command places multiple images into the
same document. You can import scanned images using the Import command in
the File bar menu (Menu bar for MAC) pointing to Import and then clicking WIA
Support. To open a video file use the Open command. You need to make sure
All Formats is selected in the Files of Type menu. To open a video file into an
open document select Layer on the Application bar (Menu bar for MAC), point to
Video Layers, and click New Video Layer from File.

To optimize images for publishing on the web and mobile devices you can use
the Save for Web and Devices command in the File menu. The Save for Web
and Devices dialog box allows you to preview your images using different file
formats. It also allows you to compare two different file formats for the same
image side by side.

Contact sheets are an array of images printed or viewed together in a smaller
scale usually created for proofing. You will need to use Adobe Bridge to create
your contact sheets in Photoshop. You can Launch Bridge by selecting the
Launch Bridge button on the Application Bar. There are standard contact sheets
available in Bridge and it also allows you to create custom contact sheets.
Adobe Bridge assists you in organizing your work and open files in different
Creative Suite applications, such as Illustrator, Fireworks, and Dreamweaver.

Photoshop also has a Picture Package plug-in. This plug-in allows you to create
various sized picture packages with multiple copies.

Reusing images (banners and logos) you have created adds to your design



consistency and flow to you projects. Smart Objects in Photoshop allows you to
perform non-destructive edits to your images so you can maintain the integrity
of the original image and reuse it. You can convert a layer into a Smart Object,
place a Smart Object in a PS document or open an image as a Smart Object.

Photoshop allows you to create templates. To do this you need to convert a
layer into a Smart Object by selecting Layer on the Application bar, point to
Smart Objects and then select Convert to Smart Object. To use the template on
another image, go to the layer that contains the Smart Object, select Smart
Objects on the Applications bar and then select Replace Contents

There are many techniques to make reusing images, swatches, brushes,
patterns, and custom shape easy and consistent. One technique is using the
Preset Manager. Preset Managers helps you manage different libraries for
custom shapes, brushes, swatches, patterns, and styles. You can find the Preset
Manager on the Application bar.

There are many Keyboard shortcuts in Photoshop. The most common are copy
and paste. To copy, click on your selection and press Ctrl+C (command+C for
MAC), to paste press Ctrl+V (command+V MAC).

Photoshop Color Management

There is a color management system in Photoshop in the Color Settings dialog
box that permits you to manage color settings. Select Color Settings on the Edit
Menu to open the Color Settings dialog box. You can color manage Working
Spaces such as RGB and CMYK, Color Management Policies and color settings for
printers in a specific part of the world. Photoshop gives you an option to either
have the images set to the specifications in the Color Settings dialog box or to
Ask When Opening the image file.

You can also manage the color of an image by selecting to edit the image using
existing and custom color management profiles. Select Edit and then click on
Assign Profile to apply a color profile to your image if it does not have an
embedded color profile. Select Edit and click on Convert Profile to change the
color profile of your image if it does have and embedded color profile.

Publishing Digital Images using Adobe CS5

You can create a web photo gallery in Photoshop using Adobe Bridge. Click the
Launch Bridge icon on the Application bar. You can open the Output panel by
selecting the workspace switcher. Here you can create a PDF or Web Gallery.
Select the Web Gallery button in the Output panel and then select the Template
menu to apply a layout for the web gallery. Once you have chosen a template,
Bridge places the images you selected in the Content panel in the web gallery.
You can preview your web gallery by selecting the Refresh Preview button.

It is important to check the file size, dimension and file format if you are
preparing a Photoshop document for video. You can select a preset video value
for your documents in the New dialog box. Click the Preset menu, and then



select Film and Video. You can select a broadcast format and pixel aspect ratio
for your document in the New dialog box.

Make sure you label and organize your layers in your Photoshop document
before you bring them into your video editing application. When you import a
document containing layers, you can save the information such as masks and
layer effects.

Safe-Zones (margins) are designed to make sure certain content is not missed
when played on T.V. screens. The safe-zones consist of two areas: the title safe-
zone and the action safe-zone. The title safe-zone is the inner margin and the
action safe-zone is the outer margin. You can apply a Title Safe Overlay from the
Actions panel. This action creates a title-safe overlay that displays title-safe and
action-safe boarders.

Identifying Design Elements when Preparing Images
Image Size: Resolution vs Dimensions

When discussing the “size” of an image it is easy to get confused, since
terminology for print is often inconsistent with terminology for the web. The term
“resolution” is really only meaningful for print, where “dots per inch” (dpi),
“pixels per inch” (ppi) and “lines per inch” (Ipi) have a direct corollary on the
printed page. But consider an element designed for HDTV display at 1920 x
1080: a desigher has no idea what size screen the viewer is using, so the same
element might be displayed on an 10” HDTV studio monitor, or on a 60-inch
widescreen TV. In both cases the pixel dimension are the same, but the
resolution is wildly different... on the 11” monitor the resolution might approach
200ppi, but on the big screen TV the resolution might be closer to 40 ppi, even
though the total humber of pixels hasn’t changed. In other words, the concept of
“x per inch” makes little sense.

In Photoshop, resolution is calculated using a combination of dimensions and the
number of pixels, but the final byte-size of the image is only determined byt the
actual number of pixels contained in the image. For example, a 10-inch by 10-
inch image at 300 ppi will be 3000 x 3000 pixels... and a 30-inch x 30-inch image
at 100 ppi wil be... 3000 x 3000 pixels. As far as Photoshop is concerned, these
images are the same “size” even though their scale is different when printed (or
placed in another app like InDesign).

Resampling an Image: When you use the image size dialog box in Photoshop, a
critical checkbox to pay attention to is “resample image”. If this is turned off,
then changing the width and height of the image will result in a corresponding
change in the Resolution of the image, in order to preserve the pixel integrity of
the image. If “resample image” is turned ON, however, then Photoshop will have
to generate new pixels to accommodate the new resolution.

Tip: Scaling down an image is usually more forgiving than scaling an image up.
When reducing the number of total pixels in an image (downsampling), choose



the “Bicubic Sharper” setting to make the results crisp and clear. When
increasing the number of pixels in the image (upsampling), choose the “Bicubic
Smoother” selection for best results. In either case, expect the enlarged result to
look a little softer than the original, and expect the smaller version to look a little
sharper.

You can transform entire images, layers or sections. Transforming changes the
look of an image by manipulating the images physical characteristics. In
Photoshop CS5 you can manipulate the image by flipping the image horizontally
or vertically, rotating, scaling or skewing. You can find these commands in the
Application Bar (Windows)or Menu Bar (Mac), select Transform and then the
command. To execute multiple transformations to an image select Free
Transformation.

Choosing an Appropriate Format

When working within Photoshop, especially on a complex design including text or
other elements, you’ll want to save your files as native Photoshop files (PSD).
PSD is an efficient format and saving to PSD insures that your text remains
editable, effects can remain live, and layer data is preserved. And other apps in
the Adobe suite support native psd files, so as long as you are working in a
CS5.x application, you should be able to import and work with native psd.

Outside of Adobe, you have a few additional choices to make. Almost every
modern application supports jpeg just fine, and if you need to preserve crisp text
or high resolutions, most applications support pdf format as well, so both of
those choices are safe for most cases. Photoshop offers a much wider variety of
formats however, many of them for legacy workflows. Here’s a general
breakdown of many formats, and the field in which they are significant:

Photography: PSD, TIF (TIFF), JPG, PDF, DICOM, DNG, Camera RAW (not to be
confused with Photoshop’s raw format), Large Document Format.

Web: JPG, GIF, PNG (especially PNG-24, which supports transparency)
Commercial Print: TIFF, EPS, PDF, PSD, DCS

Microsoft Office: JPEG, PNG, BMP

Video: PSD, JPEG, TIFF, PNG, Open EXR

High-End Visual Effects: Open EXR, Targa, Cineon

Design Considerations

For most students of digital media, a great deal of time is spent in learning how
tools work, but unfortunately it can be difficult to find good information about
what makes a good design. While we don’t have time to cover this topic in detail



here, we can point out some general topics that are worth understanding:

Aspect Ratio: This is a mathematical expression of the layout of an image. In
broadest terms, an aspect ratio can be square (as wide as tall), landscape (wider
than tall) or portrait (taller than wide). In more specific terms, aspect ratio is
usually expressed as the smallest whole-number divisor of the total resolution.
For example, 640 x 480, 800 x 600, and 1024 x 768 are all usually expressed as
the aspect ratio “4:3” (pronounced “four by three”).* 4:3 is commonly seen in
TV production and some old movies, as well as on older computer screens.
Modern TVs and Computer screens are often 16:9 or 16:10, and may movies are
even wider.

*In video production you might find an aspect ratio expressed as a decimal value
so that the second value in the ratio is equal to 1... for example, a 4:3 aspect
ratio might also be expressed as "1.33:1”, and 16:9 is sometimes referred to as
“1.77:1”.

Framing: This refers to the composition of the shot, including the placement of
the subjects and any other elements that are included in the shot. It's a big
subject, but includes concepts such as “white space” (empty areas of the screen
that draw your attention to the other elements), the “rule of thirds” (which
assumes that dividing the scene into thirds and arranging elements along these
imaginary dividing lines will result in a more-aesthetically pleasing composition),
and “balance” (a more aesthetically-complex concept that can be generalized as
“using secondary elements to reinforce the main element of the scene”. All of
these will serve to draw the observer’s eye to the most important thing (the
“focal point”) of the design.

The Crop Tool: While an experienced photographer will strive to accomplish
most of these things in camera, the most useful tool to adjust the framing of an
image in Photoshop is the crop tool. Take a close look at it the next time you use
it and you’ll even see the “rule of thirds” guides present in the tool. While most
commonly used to trim the edges of a in image to re-frame it, the crop tool can
also be used to straighten an image. When simply cropping, the original pixels
are preserved... but when straightening or cropping to a custom size, the pixels
of the image will be resampled, and the same rules of thumb will apply as when
simply resizing an image.

Field of View: This photographic term relates to the angle of the scene that the
lens is capable of capturing. If the photographer is standing in the same place, a
wide-angle lens will include more of the scene in front of them, and a telephoto
lens (with its narrower field of view) will capture a much smaller part of the
scene in front of the photographer. Field of view will also determine the amount
of perspective present in an image, with a wide field of view having much more
distorted results, and a zoom lens producing a “flatter” final image.

Field of view, combined with rules of framing, can produce some surprisingly
different results in an otherwise similar scene. You can walk closer to a subject
with a wide-angle lens, or further away from a subject with a zoom lens, and
approximate the exact same framing... but the resulting distortion will produce



two very distinct images, especially with human subjects. In general, a zoom
lens is better for flattering portraits, since a wide-angle lens tends to distort and
exaggerate a subject’s features.

Foreground & Background: It is often desirable in an image to separate the
foreground subject(s) from a less distinct, or otherwise contrasting background.
A common way of doing this is with focus, where the foreground elements are
sharp, and the background elements are indistinct. This is commonly
accomplished in camera by manipulating the depth of field, which uses a
combination of aperture, lens speed, and ISO to determine how much of the
scene in front of the lens is sharp, how much is blurry, and how quickly the
scene transitions from one state to the other.

Color & Tone: Among the tools for manipulating the emotion of the viewer,
color and tone are arguably the most powerful. Whether you need a natural-
color image to preserve the reality of a scene, or subtly apply a tonal cast to an
image to create a sense of nostalgia, or remove the color image altogether to
imply and aged (or art-house) effect, manipulation of color and tone is a critical
design component.

Contrast: Contrast can either refer to the subject matter of a scene, where an
important element is drastically different from the other elements (for example,
imagine a bikini model standing among a group of nuns), or contrast can refer to
the lighting of a scene, where in a high-contrast scenario the scene has an
abundance of blackest blacks and whitest whites vs. a low-contrast scene where
the scene contains a more subtle distribution of gray.

Additional Design Considerations: Through experience and study, a designer
will learn to wield the above elements with skill, as well as incorporate additional
design concepts such as line, shape, form, texture, and harmony... with the
ultimate goal of achieving artistry in one’s designs.

Color Space and Bit Depth

Color Space: While there are many different ways of modeling color in a
computer, there are generally two common ways for designers to display color:
RGB and CMYK.

RGB is a “transmissive” or “additive” model, where different intensities of three
colors of light (red, green, and blue) are added together to produce a spectrum
of color. RGB is typically used to display images on computers, TVs, and portable
devices.

CMYK is a “reflective” or “subtractive” model, where different amounts of colors
of ink (specifically, Cyan, Magenta, Yellow and Black) are mixed together and
printed on a page or other surface to produce a spectrum of color. Printed color
has no light of its own and is expected to reflect the light from another light
source.



100% intensity of color in an RBG sytem produces pure white. 100% intensity of
all color in a CMYK system produces “rich black”.*

*In CMYK you can also produce black by using only black ink, but a rick black
will look deeper and more intense.

Bit Depth: In any color system, bit depth refers to the number of values used by
each “channel” in the system (in an RGB system, Red, Green and Blue are
channels). Sometimes people will add the channels together, and thus refer to
an 8-bit-per-channel(bpc) image as a “24-bit image”.

8-bpc: The most common format, supports 256 shades of each color, for a total
of 16.7 million possible colors. Computers, TVs and portable devices typically
operate in this color range. In an 8bpc system, color values are typically
assigned in a range from 0(black) to 255(white).

16-bpc: Supports approximately 64,000 colors per channel, or billions of total
theoretical colors, although devices that can display this depth are not currently
available. However, the added color resolution allows a designer to do much
more dramatic color corrections without running into posterization and other
color degradation problems.

32-bpc: This high-end format, also called "HDR” (for high-dynamic range) or
“float” (for floating-point) allows a designer almost complete freedom to
manipulate color and contrast with almost no danger of damaging an image. It
accomplishes this by not only storing data in visible light, but also allowing data
as “brighter-than-white (superbright) or “blacker than black” (superblack).
Among other advantages, HDR color space allows bright colors to behave like
real light, instead of simply “clipping”.

Image Sources

Digital Cameras: From dedicated SLRs to cell phones, from tablets to handheld
video games, digital cameras are everywhere and almost everyone has at least
one. The quality of a camera will vary wildly based on price, the size of the
sensor, the quality of the lens, the resolution of the sensor (measured in
megapixels), and on the light sensitivity of the camera. It is up to you to learn to
shoot good pictures with your device, but in all cases the pictures will end up
stored on the camera’s internal drive, and you will need to import the image into
Photoshop to work with them. There are many ways to do this—some of which
involve many steps—and there are more methods introduced almost every day.

The typical way to ingest a digital photo from a camera is to use a cable to
connect the camera physically to the computer. Once connected, a user can
employ the camera’s proprietary software, or an intermediate client like Adobe
Bridge, to import the photos from the camera to a folder on the computer.
Recent developments have allowed this process to be streamlined, with the
Adobe Cloud, Adobe Carousel, or Flying Car’s Acquire for Photoshop allowing a
user to beam a photo from a device into the user’s computer (or in the case of



Acquire, directly into Photoshop).

Digital Cameras typically all produce files in jpeg format, and some high-end
cameras can also shoot to Camera RAW format. Camera RAW allows for greater
freedom in developing the photo down the road, but the files are much larger
than jpegs, so you can store fewer RAW files on a given device.

This is not a how-to-be-a-photographer course, but it is worth mentioning that
you should get to know your camera well so you can shoot the best source
images possible from your device. While it is tempting to say “I'll fix it in post”,
you will be a much happier designer if your source images are properly lit, in
appropriate focus, and are otherwise high-quality.

Scanners: The availability of high-quality digital cameras have all but killed the
market for film, and there are signs that the scanner market is suffering as well.
However, there are still good reasons to use a scanner, especially when you
need to produce the highest-possible-quality image from a printed source.

To ingest an image from a scanner, you'll typically use the software that ships
with the device to preview, crop, and then scan the final version of the image.
You will have options to choose resolution, bit depth, format, destination, and file
name. Once scanned, the image will be available on your computer just like any
other digital image.

What’'s Up with Non-Square Pixels?

Many legacy video and film formats use display devices (old, SD TV sets) or
lenses (VistaVision) that stretch the image when it is displayed. In order to work
with the image on your computer in the final, viewable aspect ratio, the pixels
that make up the image need to be interpreted as rectangular rather than
square. For example, NTSV video has an aspect ratio that is slightly squeezed
vertically (.9:1), while the HDV format is much more dramatically squeezed
(1.55:1). Unless you work in video or film this will not be a big concern for you,
and in either case there are arguments to always work in square pixels, and let
the video operator handle the “squeezed” pixels at a later time.

MANIPULATING IMAGES USING ADOBE PHOTOSHOP CS5
Analyzing Images

An often-overlooked feature set in Photoshop Extended is contained in the
“Analysis” menu. Designed for scientific and health-care analysis, these tools can
also be useful for certain design situations. In general, the analysis tools allow
you to precisely measure the length and area of objects in a scene, and make it
easy to count large numbers of elements.

By default the tools measure using a scale of “pixels”, which is all Photoshop can
understand without your help. However, if you know the length on an element in
your scene, use the “Set Measurement Scale” menu option to enter a more



appropriate value. For example, if you know that a stack of 16 pennies is exactly
one inch, then you can choose “custom” from the “set measurement scale” menu
and then drag a ruler on screen to define the height of the penny stack, then
enter “1” into the “logical length” field and “inch” into the “logical units” field.
Now, subsequent measurements will all use this scale. If you now use a selection
tool to select all of the pennies, it will tell you the stack’s surface area in square
inches, as seen in the image.

To view this information, first make a selection, then choose “record
measurements” in the analysis menu. This will open the Measurement Log at the
bottom of the screen, and display your results. Subsequent measurements will
add to the log.

Custom Panels

You may discover as you work in Photoshop that the tools you use are not
conveniently arranged for your workflow. Using an application called Adobe
Configurator, you can create custom panels and use them in Photoshop. Visit
labs.adobe.com/technologies/configurator and download the Configurator
installer. To make a custom panel simply drag and drop the tools and commands
you want into the new panel. When you are finished, export your panel to
Photoshop, open (or restart) Photoshop, and your new panel will appear under
the Window->Extensions submenu.

Custom panels are great for tools but you can also use them to load images or
even video. For example, you can create a panel that contains the SWF Image
Loader widget, which allows you to load GIF, PNG, JPEG and SWF files into
Photoshop. You can even use the Movie Player widget to load FLV (flash video)
or MOV movie files.

Batch Processing with Actions and Droplets

In many situations you will need to repeat a series of steps on a large number of
files. This kind of repetition can be very tedious, but fortunately Photoshop offers
a few different ways to automate the process. The core tool for accomplishing
this is the Actions panel. Here you’ll see a large variety of preset actions to use
and examine, and you are also presented with some familiar tools for creating
and organizing your own actions.

In general, you create a new action by selecting the “new action” icon at the
bottom of the Actions panel, nhaming the action, pressing the “record” button,
then choosing the steps you wish to repeat in sequence. When finished, press
the “stop” button at the bottom of the Actions panel, and your new action should
appear in the list. To apply your action to a new document, simply open the
document, select the action in the list, and push the play button.

To apply an action to a large number of documents at once, you can create a
“Droplet” from any action (or series of actions). Select File->Automate->Create
Droplet, and use the droplet interface to choose the actions you want to apply to
the files, where to save the resulting processed files, as well as many other



choices. Once you have saved your droplet, it will appear as a file on your
computer, and now to batch-process a series of images you can simply select the
images as a group and drag them on top of the droplet.

Using Guides & Grids

Guides are a useful feature for aligning elements in your documents. To add a
guide you can navigate to the View menu and choose “"New Guide”, which will
allow you to choose a horizontal or vertical guide and precisely position it. If you
don’t know the position you want, don't worry, you can always reposition an
unlocked guide with the move tool. Many users prefer to add guides by first
enabling the rulers, after which you can drag new guides in by clicking in the
horizontal or vertical ruler and dragging into the document.

The Guides submenu also allows you to lock guides, hide guides (using the “hide
extras” option), turn on and off guide snapping, and even delete guides. To
further customize guide appearance, go to the “Guides, Grid and Slices” option in
Photoshop preferences, where you can change a guide’s color, set it to “dots”
instead of solid lines, and other options.

Grids are a different kind of guide that can’t be dragged around manually, but
rather subdivide the screen into preset amounts to aid in alignment and
distribution of elements. You enable and disable a grid’s visibility in the view
menu, and adjust its dimensions and appearance in the preferences pane.

In either case, it is recommended to turn off grids and guides before sending a
document to another designer or a printer... if a user is unfamiliar with guides
their appearance may be confusing.

Domain 5.0
Publishing Digital Images using Adobe Photoshop CS5

Creating a Web Photo Gallery

One common (and increasingly critical) way to share your images with others is
on the web, and Adobe provides a way, using Adobe Bridge, to create a Custom
Photo Gallery via

A web photo gallery is a website that features a home page populated with
thumbnail images which link to gallery pages displaying full-size images. Adobe
Output Module provides various gallery templates, which you can select and
customize using the Output panel.

. Select the images you want to include in the gallery and choose Window >
Workspace > Output. Then, click the Web Gallery button at the top of the
Output panel.

o Choose a gallery from the Template menu and specify a
thumbnail size from the Style menu. Then, customize the appearance of
the gallery using the options in the following drawers: Site Info Specify
information that appears on every page of the gallery, including a title, a
description, and contact name and e-mail address.

Color Palette Options vary depending on selected template. Choose



colors for different elements of the gallery, such as text, header text,
background, and borders.

Appearance Options vary depending on selected template. Specify the
size of images and thumbnails, the quality of the JPEG images, transition
effects, layouts, and whether to include filenames on HTML gallery
images.

Image Info (Airtight galleries only) Include a caption, based on image
metadata, on gallery images.

Output Settings (Airtight galleries only) Specify the size and quality of
JPEG gallery images.

o Click Refresh Preview to view the gallery in the Output
Preview panel in Adobe Bridge. Click Preview In Browser to preview the
gallery in your default web browser. Important: Gallery previews display
up to 20 files, but the complete gallery is saved and uploaded.

o (Optional) Save custom settings for reuse by clicking the
Save Style button.
o To upload your gallery via FTP, open the Create Gallery

drawer. Enter an FTP Server address, User Name, Password, and Folder
destination. Then, click Upload. To save your gallery on your hard drive,
open the Create Gallery drawer and specify a Save Location. Then, click
Save.

Exporting Images for use in Video Applications

Many times you will be preparing images that will ultimately be used in video
applications such as Adobe After Effects or Adobe Premiere. In these cases there
are a few tips you’'ll want to keep in mind.

Try to work AT LEAST at the pixel resolution of the output device. In other
words, if creating an element that will be output to DV, you’ll want to work at a
minimum resolution of 720 x 480 pixels, and a pixel aspect ratio of .9:1. There
are presets in Photoshop of most common output resolutions and formats.

The reason we say “at least” is because many times you will want to create an
element at a higher resolution in order to give a designer the freedom to zoom
in, crop or otherwise manipulate the Photoshop element. Extra resolution will
allow for greater manipulation before the image starts to “fall apart”.

One common element of most video presets is a series of guides related to "Title
Safe” or “Action Safe”. Inside an image’s full frame is a slightly smaller rectangle
(Action Safe) and a slightly smaller rectangle inside that one (Title Safe). This
concept dates back to the day when TVs came packaged in large boxy pieces of
furniture and often had large bezels or other pieces of trim that could cover up
the edges of the TV screen. Thus the “Title Safe” area is the part of the screen
where you can count on everybody being able to read your message, and Action
Safe is a slightly larger area where you can always expect to see what is “going
on”. While this idea is slowly disappearing as more people adopt flat panel TVs
with no (or very small) very small bezels, there are still standards for broadcast
television that must be observed. Make sure you know whether your target
output requires Title or Action-Safe while you are designing your elements.

In addition, many video formats support (or require) non-square pixels.
Photoshop gives you the option to work in these unusual aspect ratios and



accurately preview how the images will ultimately display. However, in most
cases, video software is sophisticated enough to resample (or “conform”) a
square-pixel image to a non-square image on its way to output, so it really
depends on your workflow whether you need to bother with non-square pixels in
Photoshop, or not.

Lastly, you should be aware of color space issues when working with images for
video. In most cases you will be expected to deliver RGB images, and if you are
finishing the video in a color-managed environment, you are encouraged to use
the same color space (sRGB, for example) in both Photoshop and your video
environment. This will insure that you aren’t surprised with any unexpected color
shifts on the way from your computer to the video screen.



